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Overall Guidelines 
• Dimensions are given as width x height unless otherwise noted 

• Default image size is 2100 wide x 1400 high pixels at 72ppi (pixels per inch) resolution 

• For image sizes, see http://rutgers-pattern-lab.herokuapp.com/ 

• Export photos and save them for web as optimized JPEG files 

• Save graphics or artwork as PNG files  

• Note that the RCCL system will not accept images larger than 2MB 

• For more information on using images with the RCCL, visit rccldemo.rutgers.edu/images 
 

Landing: Informational 
Hero–Swoosh 

• There are two color options–white 
and red (as shown) 

• The image occupies only the shaded 
area 

• Size images to 2100 wide x 1400 high 
pixels at 72ppi  

Landing: Marketing 
Full-Width Hero 

• The image is full width and uses 
most of the height 

• There is an overlay tint on the entire 
image to accommodate the 
mandatory title and optional 
description 

• Size images to 2100 wide x 1400 high 
pixels at 72ppi  

Landing: Secondary 
Basic Hero 

• The image is full width but uses a 
portion of the height 

• After uploading, adjust the focal 
point in the preview to target the 
area that works best 

• There is a gradient overlay tint from 
bottom to top to accommodate the 
optional text 

• Size images to 2100 wide x 1400 high pixels at 72ppi  

http://rutgers-pattern-lab.herokuapp.com/
http://rccldemo.rutgers.edu/images
http://rutgers-pattern-lab.herokuapp.com/?p=templates-landing-informational
http://rutgers-pattern-lab.herokuapp.com/?p=components-hero-swoosh
http://rutgers-pattern-lab.herokuapp.com/?p=components-full-width-hero
http://rutgers-pattern-lab.herokuapp.com/?p=components-hero-basic-bg-image


 
 

Rutgers Core Component Library Image Sizing Guide 
 

 

4 

50/50 
• A horizontal image is preferred. The entire height of 

the image is used and will adjust according to how 
much text there is. 

• Size images to 2100 wide x 1400 high pixels at 72ppi 

• After uploading, adjust the focal point in the 
preview to target the area that works best 

• If using a vertical image, background must be added 
to the image. Create a canvas in Photoshop that is 
2100 wide x 1400 high pixels at 72ppi and center 
the vertical image on a matching background color. 

 
 

Animated 50/50 Image 
• It’s the same as a regular 50/50 but needs to be 

adjusted when using vertical images  

• If using a vertical image, background must be added 
to the image. Create a canvas in Photoshop that is 
2100 wide x 1575 high pixels at 72ppi and center 
the vertical image on a matching background color. 
 
 

Animated Chapter 
The full image width will be used  

• The image depth will adjust 
according to the amount of copy 
positioned left or right 

• Size images to 2100 wide x 1400 
high pixels at 72ppi  

 
Tip: Have your subject more to the right 
or left if you are using this component. 
This is only available with the Feature 
Article. The ghosting effect under the text 
is automatic and is not optional. 

  

Original image 

http://rutgers-pattern-lab.herokuapp.com/?p=components-promo-50-50
http://rutgers-pattern-lab.herokuapp.com/?p=components-animated-50-50
https://rccldemo.rutgers.edu/news/feature-article-content-type
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Article Heroes 
• Size images to 2100 wide x 1400 high pixels at 72ppi  

• Two hero options 
1. Headline on Image: the top and bottom of the image are not visible. There is a 

gradient overlay tint from bottom to top to accommodate the text. 
2. Headline and Image: the full image is displayed with no overlay tint 

 
 
 
 
 

 

Description & Card Carousel 
• Size images to 1000 wide x 563 high pixels at 72ppi 

 

 
 

 
 

Headline on Image 

 
Headline and Image 

 

http://rutgers-pattern-lab.herokuapp.com/?p=components-description-card-carousel
http://rutgers-pattern-lab.herokuapp.com/?p=components-hero-headline-over-image
http://rutgers-pattern-lab.herokuapp.com/?p=components-hero-headline-image
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Description & Image Cards 
Two size options 

• Size images as a square at 1000 wide x 1000 high pixels at 
72ppi 

• The default size of 2100 wide x 1400 high pixels at 72ppi can 
also be used. The system automatically uses the center of 
the image unless you upload the image using the square 
dimension. 

 
 

Descriptive Links 
• The image is full width but uses a portion of the height to 

accommodate copy that appears on the overlay tint 

• After uploading, adjust the focal point in the preview to 
show the area that will work best 

• Size images to 2100 wide x 1400 high pixels at 72ppi 
 

 
Original image 

 

 

http://rutgers-pattern-lab.herokuapp.com/?p=components-description-image-cards
http://rutgers-pattern-lab.herokuapp.com/?p=components-descriptive-links-bg-image
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Display Cards with Rollover 
• Use three images to fill the browser width 

• Size images to 2100 wide x 1400 high pixels at 72ppi 
 

 
 

Enhanced 50/50 Video 
• The component uses the thumbnail that was assigned to that video 

 

 

  

http://rutgers-pattern-lab.herokuapp.com/?p=components-display-cards-rollover
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Enhanced Photo Gallery 
• Horizontal images should be sized to 2100 wide x 1400 high pixels at 72ppi  

• Vertical images should be sized to 1400 wide x 2100 high pixels at 72ppi 
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Feature Article Hero 
• There is an overall overlay tint to accommodate the text 

• Size hero image to 2100 wide x 1400 high pixels at 72ppi  
 

 
 

Featured Event  
• Size images to 1000 wide x 563 high pixels at 72ppi 

• The default size of 2100 wide x 1400 high pixels at 72ppi can also be used 
 

 
 
 

http://rutgers-pattern-lab.herokuapp.com/?p=templates-rur-article
http://rutgers-pattern-lab.herokuapp.com/?p=components-events-display-featured
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Featured Summaries 

Image Card 
• Size images to 1000 wide x 563 high pixels at 72ppi 

 

 

 

Featured Topic 
• The image is full width but uses a portion of the height to accommodate copy placed on 

the overlay tint 

• Size images to 2100 wide x 1400 high pixels at 72ppi 
 
Tip: Converting the background image to grayscale helps to highlight the information 
 

 
 

  

http://rutgers-pattern-lab.herokuapp.com/?p=components-topic-listing-three-col
http://rutgers-pattern-lab.herokuapp.com/?p=components-featured-topic
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Full-Width Video 
• A poster image (static image) needs to be uploaded and sized to a 16:9 aspect ratio of 

1920 wide x 1080 high pixels at 72ppi 

• The default size of 2100 wide x 1400 high pixels at 72ppi can also be used. Note that a 
small portion of the top and bottom will not be visible to adhere to the aspect ratio. 

Tips:  

• The poster image is visible prior to playing the video. If one is not added, then the image 
will be blank.  

• A screenshot of an image will work if a bigger image is not available. See the section on 
How to Take a YouTube Screenshot and Save as a JPEG. 

 

With poster image      Without poster image 

 

Person Card 
• Size image to 634 wide x 846 high pixels at 72ppi  

Tip: Try to keep the size of the person’s head consistent with one another for a uniform look 
 

        
 
 
 

http://rutgers-pattern-lab.herokuapp.com/?p=components-video-full-width
http://rutgers-pattern-lab.herokuapp.com/?p=components-people-collection
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Photo Feature 2-Column 
• A horizontal or vertical image will work for this 

• Size images to 2100 wide x 1575 high pixels at 72ppi or 1575 wide x 2100 high pixels at 
72ppi 

 

 
 

Program Finder 
• The image is full width but uses a portion of the height to accommodate copy on the 

overlay tint 

• After uploading, adjust the focal point in the preview to show the area that will work 
best 

• Size images to 2100 wide x 1400 high pixels at 72ppi 
 

 
  

http://rutgers-pattern-lab.herokuapp.com/?p=components-promo-photo-2col
http://rutgers-pattern-lab.herokuapp.com/?p=components-program-finder
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Rich Text  
Inline image 

• A minimum image width of 500 pixels and maximum image width of 2100 pixels can be 
added to the rich text component. There is no depth (height) restriction. 

• There are three image display options. The “Embed” will place the image at half the 
content width, and “Embed-Small” will display it at 1/3 the content width. 
 

 
Image at half the content width 

 

Slideshow 
• Size images to 1000 wide x 753 high pixels at 72ppi  

 

 
 

 
 

http://rutgers-pattern-lab.herokuapp.com/?p=components-slideshow
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User Choice Carousel 
• Choose an image that has dead space on the image’s left side to allow for the text 

• When placed, the component will not show a portion of the top and bottom of the 
image 

• Size images to 2100 wide x 1400 high pixels at 72ppi  
 

 
Original image 

 

 

User Choice Vertical Tabs 
• Size images to 1000 wide x 563 high pixels at 72ppi 

• The default size of 2100 wide x 1400 high pixels at 72ppi can also be used. Note that a 
small portion of the top and bottom of the image will not be visible. 
 

 
 
 
 

  

http://rutgers-pattern-lab.herokuapp.com/?p=components-user-choice
http://rutgers-pattern-lab.herokuapp.com/?p=components-user-choice-vertical
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How to Optimize Images 
 

1. Under File>Export>Save for Web 

 
 

2. When the window opens, adjust the quality from 50–75%, depending on the photo’s 
clarity. Note that some colors will not be as vibrant at a lower optimization. 
 

3. You can preview the image in the browser before saving the file as a JPEG. 
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Image Naming Conventions 
 
Images Downloaded from MerlinOne 
Most images downloaded from MerlinOne, the university’s digital asset library, will be at least 2880 
wide x 2160 high so that they can be used anywhere on the site. In some cases, images will be sized for a 
specific space and will maintain the current file name and have the appropriate designation appended:  

• event_ = used for event 

• grab_ = screengrab from video 

• lg_ = Common Images (max size) 

• mag_ = Magazine cover 

• sm_ = Homepage Mosaic, Stats Image 

• pub_ = In the News | Publication Icon 

• pro_ = profile image 

• prmo_ = Rutgers Today article promotional 
thumbnail image 

• x_ = images should not be reused 

  
Images from Elsewhere 
These images can be any size, so it will be important to indicate their size as they are added to the site. 
Images from elsewhere will use the same size designations as UCM images: 

• event_= used for event 

• lg_ = Common Images (max size) 

• mag_ = Magazine cover 

• sm_ = Homepage Mosaic, Stats Image 

• pub_ = In the News | Publication Icon 

• pro_ = profile image 

• prmo_ = Rutgers Today article promotional 
thumbnail image 

• x_ = images should not be reused  

  
In University Communications and Marketing, a school designation will also be appended so they can be 
traced back to their source.  The school designations are: 

• _ccas = Camden College of Arts and 
Sciences 

• _cs = Continuing Studies 

• _ejb = Edward J. Bloustein School of 
Planning and Public Policy 

• _pharm = Ernest Mario School of Pharmacy 

• _gsapp = Graduate School of Applied and 
Professional Psychology 

• _gse = Graduate School of Education 

• _gsc = Graduate School–Camden 

• _gsn = Graduate School–Newark 

• _mgsa = Mason Gross School of the Arts 

• _njms= New Jersey Medical School 

• _rwjms = Robert Wood Johnson Medical 
School 

• _rbs = Rutgers Business School–Newark and 
New Brunswick 

• _rlaw = Rutgers Law School 

• _rsdm = Rutgers School of Dental Medicine 

• _sas = School of Arts and Sciences 

• _sasn = School of Arts and Sciences–Newark 

• _sbc = School of Business–Camden 

• _sci = School of Communication and 
Information 

• _scj = School of Criminal Justice 

• _eng = School of Engineering 

• _sebs = School of Environmental and 
Biological Sciences 

• _sgs = School of Graduate Studies 

• _shp = School of Health Professions 

• _smlr = School of Management and Labor 
Relations 

• _sn = School of Nursing (Newark and New 
Brunswick) 

• _snc = School of Nursing–Camden 

• _spaa = School of Public Affairs and 
Administration 

• _sph = School of Public Health 

• _ssw = School of Social Work

https://rutgers.merlinone.net/mx/Profiles/en/landing/
https://communications.rutgers.edu/about
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How to Take a YouTube Screenshot and Save as a JPEG  
  

1. Download the Google Chrome browser extension “hyde” or something similar. The hyde 
extension allows you to hide the playback controls on YouTube. 

  
2. Go to your YouTube video. 

 

 
  

3. Check the gear icon on the playback bar to ensure the video quality is as high as 
possible, e.g., 1080p. 

  

 
 

  
  

https://chrome.google.com/webstore/detail/hyde-%E2%80%94-hide-the-youtube-v/pmkpddhfbiojipiehnejbjkgdgdpkdpb
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4. Navigate to the screenshot you need.   
Tip: Use the left and right arrow keys to advance/rewind in 5-second increments; use the 
comma (,) and period (.) keys to advance/rewind by 1 second. 
 
When you’ve found the moment in the video you want to screenshot, pause your video 
and bring your player to full-screen mode (note the rightmost, broken square icon in the 
playback bar below). 

  

 
  

5. Activate the hyde extension by pressing Ctrl+M to remove the playback controls.  
 

6. Take a screenshot. (On a PC:  Shift+Windows key+S. Use the toolbar at the top of the 
screen to take a full-size screenshot. On a Mac: Command+Shift+3) 

  

 
 

7. Open Photoshop or your photo editing app of choice and create a 2100 wide x 1400 high 
pixel at 72ppi canvas, or one sized to meet the needs of your use case.  
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8. Place your screenshot over the canvas. (On a PC: Window key+V to paste from 
clipboard; On a Mac: drag the screenshot file from your Finder into your photo editor.) 

  

 
  
  

9. Scale your image to fit. (In Photoshop: Edit > Transform > Scale.) Adjust your image from 
the corner to fit completely into your canvas. Optional – edit your image by adjusting 
brightness, color saturation, or other quality edits.  

  

 
  
  

10. Export your image as a JPEG. (In Photoshop:  File > Export > Export As.) Use the quality 
of your original screenshot to determine the quality to apply to your JPEG.  Screenshots 
are generally lower quality than a true photo, so select Very Good, Great, or Excellent 
based on your judgment. Remember, the higher the quality, the larger the image file 
size. Large image files take longer to load on webpages than smaller ones. 
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11. Save the file you just made into the Media Library of your RCCL site. (Content > Media > 

Add Media > Add Image.)  
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